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Clicking on a topic or a page number will automatically take you to that section.
At the end of each section, you will see a “Return to TOC.” Clicking on this hyperlink will bring
you back to this page.
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Introduction
This document was written to help students who are working on their Sheridan High School
(SHS) senior portfolios in English and Government. The directions within this document were
written using Microsoft Word 2013 and Google Docs as these are the word processing
programs available to SHS students at the time.
This document is best used as a companion while the student is creating their portfolio.
However, if the student already has their portfolio created, this document will try to address
how students can make changes to their document to meet the assignment criteria.
For students who only want to use this document as a reference for specific topics, the Table of
Contents (TOC) has been created using hyperlinks. Clicking on one of those hyperlinks will take
the students directly to the page containing the information the student needs. A “Return to
TOC” hyperlink has been added to the end of each topic which when clicked upon will return
students to the Table of Contents.
If there are errors or misleading directions within this document, please email those errors to
Mr. Burkhart at no-dburkhart@seovec.org so that the document can be updated.
Return to TOC
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Starting Your Document
It is best to create your entire portfolio within one document. However, if you are reading this
document and have already created your portfolio in separate documents, you will need to
refer to the Creating My Portfolio from Several Documents section. This will create more work
for yourself but can be done.
The first decision you need to make to get started with your portfolio is to determine which
word processor you would like to use. Your choice should be made by thinking about your
availability to that word processing program. Do you have home and school access to the
program? Where will you be completing your work on your assignment?
The two word processing program most often used by students and most available to students
at SHS are Microsoft Word 2013 and Google Docs. This document will address the creation of
your portfolio in both programs.
Microsoft Word 2013 will allow you to easily complete all of the technical requirements of your
portfolio. However, you will need to save your work to your Google Drive or email your work to
yourself if you plan to work on your portfolio outside of school. If you have Microsoft Word
2010 at home, you will be able to access your 2013 document and vice versa.
Google Docs and Drive are now available to all SHS students. Using Google Docs and Drive will
ensure that your work is always saved. There is no save command within Google Drive because
Google Drive will automatically save your work periodically. Another advantage to using Google
Docs and Drive is that you can access your information from anywhere with an Internet
connection. If you want to work on your portfolio at home and don’t own a copy of Microsoft
Word 2013, you might want to look into using this free resource. If you choose to use Google
Docs and Drive, you will need to create your Google Apps for Education (GAFE) account. The
details for doing this can be found in the Accessing Your Google Drive section of this document.
Return to TOC
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Accessing Your Google Drive
If you haven’t accessed your Google Drive before, simply go to the Northern Local District’s
homepage (www.nlsd.k12.oh.us) and click on the Forms & Links button found in the top right
corner of the page.

Under the Links section, you will find a Links for Students area. Click on the GAFE (Google Apps
for Education) link.

This will take you to the Google Login screen. You will need to enter your Google email address
to access your account. Your Google email address is most likely your year of graduation
followed by your first initial and your last name followed by @nlsd.k12.oh.us. For example, if a
student is graduating in 2019 and their name is Stanley Yelnats, Stanley’s email would be
19syelnats@nlsd.k12.oh.us. In the case where a student has the same year of graduation, same
first initial and last name as another student, you will need to see the library or computer
teacher for your email address.
You will also need your Google account password. Your Google account password is your
student ID number followed by abcde. Your student ID number is the number you use to access
your lunch account and other school related information. If you don’t know your student ID
number, you can get it from your English or Government teacher. In our example for Stanley, if
his student ID number is 123456, Stanley will enter 123456abcde for his password.
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One you have access your GAFE account for the first time, you will need to agree to the
guidelines for your GAFE account realizing that it is school property and should be treated as
such or risk the loss of your account.
Once you have signed into your GAFE account, there will be a helpful toolbar in the top right
corner of the screen. To access your Google Drive, click on the grid and choose Drive.
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To start a Google Doc, you will click the Create button and choose Document.

You will now be taken to a Google Doc screen that looks like a piece of paper with a simple
editing toolbar at the top. The first thing you will need to do is name your document. In the top
left corner of the screen, click on Untitled document.

This will bring up the Rename Document dialog box. Enter a title for your document in the
appropriate area and click OK. This will give your document a name.
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You can now start working on your portfolio using the editing toolbar to make changes just as
you would with any word processor. Remember that with Google Docs and Drive, you never
have to worry about saving your document. Google will always automatically save it for you.
Return to TOC
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Creating a Cover Page
The cover page is the first impression of your work. You want to give your cover page a
distinctive look by adding a creative title, color and an image. Check with your teacher for the
cover page requirements for your project.
You should create your cover page as a separate document from the rest of your project. This
will allow you to print your cover page in color while the rest of your document can be printed
in black text.
After you have determined a title, enter it into your word processor. Don’t worry about the size
or color at this point, just get the information entered and changes to the text can be made
later.
After the title, you should add an image that portrays the topic of your portfolio. This can be an
image that you have taken using a camera (cell phone), one that you have found using your
word processor (Microsoft Word has its own library of public domain images. Google Docs does
not have this option.), or a public domain image that you have found on your own.

Inserting an Image
Microsoft Word 2013
Inserting an Image Saved on Your Computer
To insert an image using Microsoft Word 2013 from your computer (an image that you have
saved on your computer), click Insert > Illustrations > Pictures.

Use the Insert Picture dialog box to find the location of your image and click the Insert button.
Inserting one of Microsoft’s Public Domain Images
Note: To use Microsoft’s public domain images, you must have Internet access.
If you would like to use one of Microsoft’s public domain images, click Insert > Illustrations >
Online Pictures.
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In the Insert Picture dialog box, enter a keyword to search for within Microsoft’s database and
click the magnifying glass on the right side of the box.

Microsoft will now display images that have been tagged with the keyword you entered. You
can insert the image you want by clicking on it and then clicking the Insert button.

Return to TOC
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Google Docs
You can insert any image from your computer into your Google Doc. Click Insert > Image to
access the Insert Image dialog box.

In the Insert Image dialog box, find the blue Choose an image to upload button in the center of
the box and click it.

Navigate to find the image on your computer and click the Open button. Your image will now
be in your document.

Formatting the Text on Your Cover Page
Now that you have your text and an image on your title page, you can play around with the
formatting to make the page look the way you want.
Microsoft Word 2013
To format the text on your cover page, select the text you wish to format by clicking either
before the text or after the text and dragging across it. This will highlight the selected text.

If you leave the cursor over this highlighted text, you will see a mini formatting toolbar appear.

You can use this mini formatting toolbar to format the highlighted text.
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If you move your cursor, the mini formatting toolbar will disappear. When this happens you can
still format the highlighted text by using Home > Font and selecting the formatting you wish to
apply to the highlighted text.

Centering Text
If you want to center text horizontally on the page, DO NOT use the spacebar to add spaces to
what you think is center. This will cause you headaches later.
The proper way to center text is to highlight the text you wish to center and use the Center
button (Home > Paragraph >

Return to TOC
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Google Docs
To format the text on your cover page, select the text you wish to format by clicking either
before the text or after the text and dragging across it. This will highlight the selected text.

Next, simply use the formatting toolbar at the top of the document to change the formatting of
your text.

Centering Text
If you want to center text horizontally on the page, DO NOT use the spacebar to add spaces to
what you think is center. This will cause you headaches later.
The proper way to center text is to highlight the text you wish to center and use the Center
button.

Return to TOC
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Creating a Title Page
The title page for your project should be similar to the title page of a book. The title page of a
book includes the title and the author’s name. Check with your teacher as to the requirements
for the title page of your project.
After you have determined a title, enter it into your word processor. Don’t worry about the size
or color at this point, just get the information entered and changes to the text can be made
later. Next, enter your name as the author.
Note: If you are using Google Docs to create your portfolio, you might want to create a
separate document for your title page. When you add page numbers to a Google Doc, all pages
are numbered and cannot be removed from the first page.

Formatting the Text on Your Title Page
Now that you have your text and an image on your title page, you can play around with the
formatting to make the page look the way you want.
Microsoft Word 2013
To format the text on your title page, select the text you wish to format by clicking either
before the text or after the text and dragging across it. This will highlight the selected text.

If you leave the cursor over this highlighted text, you will see a mini formatting toolbar appear.

You can use this mini formatting toolbar to format the highlighted text.
If you move your cursor, the mini formatting toolbar will disappear. When this happens you can
still format the highlighted text by using Home > Font and selecting the formatting you wish to
apply to the highlighted text.
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Centering Text
If you want to center text horizontally on the page, DO NOT use the spacebar to add spaces to
what you think is center. This will cause you headaches later.
The proper way to center text is to highlight the text you wish to center and use the Center
button (Home > Paragraph >

Return to TOC
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Google Docs
To format the text on your title page, select the text you wish to format by clicking either
before the text or after the text and dragging across it. This will highlight the selected text.

Next, simply use the formatting toolbar at the top of the document to change the formatting of
your text.

Centering Text
If you want to center text horizontally on the page, DO NOT use the spacebar to add spaces to
what you think is center. This will cause you headaches later.
The proper way to center text is to highlight the text you wish to center and use the Center
button.

Return to TOC
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Creating Headings
Using headings within your portfolio will help you create your Table of Contents later. If you
have completed your portfolio and haven’t used headings, it will be helpful to go back and add
these headings in order to create your Table of Contents.

Microsoft Word 2013
To create a heading, first type the text for the heading and click and drag over it to highlight it.

Use Home > Styles > Heading 1 for titles of sections.

You will notice that your text is changed slightly, but other than that, you won’t notice much. If
you need other subheadings, you can choose to use Heading 2, Heading 3, and so on.
If you want to change the color, size or style for a heading, simply right-click on the heading
name in the Style area and choose Modify. In the Modify Style dialog box, you can make
changes. Making these changes will affect every instance where the heading has been used and
all new instances.

19

Return to TOC

Google Docs
To create a heading, first type the text for the heading and click and drag over it to highlight it.

Use Format > Paragraph Styles > Heading 1 > Apply Heading 1 for titles of sections.
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You will notice that your text is changed slightly, but other than that, you won’t notice much. If
you need other subheadings, you can choose to use Heading 2, Heading 3, and so on.
Another method to apply a heading style is to click the style icon and choose Heading 1.

Return to TOC
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Creating a New Page
You will want to create a new page after your title page and after each of your topics within
your portfolio. DO NOT use the Enter key until the word processor brings you to a new page.
This technique will cause you headaches later. Use the sections belong to add a new page to
your work.

Microsoft Word 2013
To create a new page in Microsoft Word 2013, place your cursor at the point where you would
like for the new page to appear (this will be the end of the text for the current page). Click
Insert > Pages > Page Break and a new page will be inserted into your document. You can
continue adding information to your document.

Google Docs
To create a new page in Google Docs, place your cursor at the point where you would like for
the new page to appear (this will be the end of the text for the current page). Click Insert >
Page Break.

Return to TOC
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Formatting the Main Section of Your Portfolio
Your teacher will set specific guidelines on formatting the text within the main section of your
portfolio. Always make sure you follow those guidelines.
Typically, a printed document is formatted using 12 pt, serif double-spaced font. The directions
here will follow these typical formatting guidelines. Again, make sure you check with your
teacher’s guidelines for the assignment.
If you set your formatting before you start creating the main section of your portfolio, your
formatting will carry through to until you change it. This is the easiest way to format your work.
If you decide to change the formatting after you have created your portfolio, you can select the
text to format by clicking and dragging the cursor over the text and the following the
procedures outlined in the following sections.

Microsoft Word 2013
Use the Formatting and Paragraph toolbars (Home > Font or Paragraph) to set the formatting
for your document.
Selecting a Font
Typically, printed text is formatted using a serif font. The most commonly used serif font is
Times New Roman. Microsoft Word 2013 by default sets the font to a sans-serif font (Calibri).
You will need to change this through Home > Font and click on the arrow beside the word
Calibri. This will display a long list of fonts available. You can scroll down to find Times New
Roman or simply start typing in Times New Roman.
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Selecting a Font Size
Typically, printed text is formatted using 12-pt font size. Microsoft Word 2013 by default sets
the font size to 11-pt font size. You will need to change this through Home > Font and click on
the arrow beside 11. This will display a long list of font sizes. You can scroll down to find the 12pt size or just type 12 to replace the 11.

Selecting Double Spacing
Typically, printed text is formatted using double spacing. Double spacing places extra space
between the lines of your text and makes it easier to read on a printed page. It also gives space
for comments and editing marks to be made between the lines of text.
By default, Microsoft 2013 sets the line spacing to single. Format your text using double spacing
using Home > Paragraph and clicking the arrow beside the Line and Paragraph Spacing icon.

Return to TOC
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Google Docs
Use the Formatting toolbar to set the formatting for your document.
Selecting a Font
Typically, printed text is formatted using a serif font. The most commonly used serif font is
Times New Roman. Google Docs by default sets the font to a sans-serif font (Arial). You will
need to change this by clicking the arrow beside the word Arial. This will display a list of fonts
available. Use your cursor to choose Times New Roman.

Selecting a Font Size
Typically, printed text is formatted using 12-pt font size. Google Docs by default sets the font
size to 11-pt font size. You will need to change this by clicking on the arrow beside the 11. This
will display a list of font sizes. Place your cursor over 12 or just type 12 to replace the 11.
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Selecting Double Spacing
Typically, printed text is formatted using double spacing. Double spacing places extra space
between the lines of your text and makes it easier to read on a printed page. It also gives space
for comments and editing marks to be made between the lines of text.
By default, Google Docs sets the line spacing to single. Format your text using double spacing by
clicking on the arrow beside the Line Spacing icon and choosing Double.

Return to TOC
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Creating Footnotes and Endnotes
Footnotes allow you to add references to the information used in your document. Footnotes
are placed at the bottom of the page where the footnote has been used. Endnotes place the
reference at the end of the document. Check to make sure which one your teacher wants you
to use.
Placing a footnote or endnote requires you to place your cursor after the word where you want
the footnote or endnote to be referenced. What will happen is that the word processor will
place a superscripted reference number (footnote) or Roman numeral (endnote) after the
word, a line at the bottom (footnote) or end of the document (endnote) separating the
document from the footnote or endnote and a corresponding number with the information
about the reference that you enter. Here is an example of a superscripted number used as a
footnote1.

Microsoft Word 2013
To create a footnote or endnote in Microsoft Word 2013, place your cursor after the word
where you want your footnote or endnote to be placed. Access the footnote or endnote icons
through Home > References > Footnote > Insert Footnote or Insert Endnote.

Microsoft Word 2013 will place the next available reference number (starting with 1) after the
word and automatically move you to the end of the page. Microsoft Word 2013 will then
expect you to enter your reference information. When you have completed entering the
information, use the cursor to click back into the main document. You will see your
superscripted number after the word and the reference material at the bottom of the page or
end of the document with the corresponding reference number.
Return to TOC
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This is my footnote.
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Google Docs
Inserting a Footnote
To create a footnote in Google Docs, place your cursor after the word where you want your
footnote to be placed. Click Insert > Footnote.

Google Docs will place the next available reference number (starting with 1) after the word and
automatically move you to the end of the page. Google Docs will then expect you to enter your
reference information. When you have completed entering the information, use the cursor to
click back into the main document. You will see your superscripted number after the word and
the reference material at the bottom of the page or end of the document with the
corresponding reference number.
Inserting an Endnote
Google Docs doesn’t currently provide a way to enter endnotes like the process for entering
footnotes. This process might be added to Google Docs in the future as Google Docs is
continually changing.
You can however, create endnotes manually with a little work. Place your cursor at the end of
the word where you would like the reference to appear. Type the next available number or
Roman numeral staring with 1 or i. Select this number by clicking your cursor and dragging over
it and click Format > Superscript.
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This will create something similar to thisi. Somewhere, you will need to write the material you
need for this reference so that when you get to the end of your document, you can enter it.
When you have finished your document, create an endnotes page with the title Endnotes and
list each number or Roman numeral with the necessary information.
Return to TOC
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Creating a Bibliography
A bibliography lists all the sources of information you used to write your portfolio. The
information used in your footnotes will also appear in your bibliography.

Microsoft Word 2013
Prior preparation for completing a bibliography while creating your portfolio will make things
easier when using Microsoft Word 2013. As you are creating your portfolio and using material
from a specific reference, use References > Citations and Bibliography.

As you enter information in your portfolio from a specific source, click the Insert Citation and
choose Add Source.

In the Create Source dialog box, select the type of source from the dialog box and complete the
areas for the source within the requested areas.
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After you have completed your portfolio and have all your sources entered, place your cursor
where you want your bibliography. You will need to know what format your teacher wants you
to use to create your bibliography. In this situation, we will assume that your teacher is asking
you to create your bibliography using the Chicago Style formatting. By default, Microsoft Word
2013 uses APA style. Click the arrow beside the Style are and choose Chicago.

Now, click on the Bibliography icon and choose the bibliography format you would like to use
(most likely you will need to use the Bibliography choice).

Your bibliography will automatically be created for you.
Return to TOC
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Google Docs
The tool to create a bibliography is not automatically include with Google Docs but is an add-on
that you can add to your Google Docs. Click Add-ons > Get Add-ons.

In the Add-ons dialog box, enter the keyword bibliography in the Search area and press Enter.

Within the results area, you should see an add-on called EasyBib. Click on the blue Free button.

You will get an additional screen asking for your permission to access information from your
document. Read through these notifications and if you agree to them, click the blue Accept
button.
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EasyBib will now be added in the Add-ons area. Click Add-ons > EasyBib > Manage
Bibliography.

On the right side of your screen, you will see a task pane to enter information to be included in
your bibliography.
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Choose the type of source you used (Book, Journal Article or Website) and enter the
information required within the information search box and click Search.
The following example, create a citation for a book on government cases. The student has
entered the book’s 13-digit ISBN number and clicked the Search button. The student then
needs to verify that the correct book has been located by EasyBib and if so, then the Select
button can be clicked.

The citation will be created within task pane and stored. The student can continue entering
sources until all sources have been documented or continue working on the portfolio.
You will need to know what bibliography format your teacher requires for the bibliography.
EasyBib allows you to create citation in MLA, APA, and Chicago styles. Clicking on one of these
formats will change the way your citations are created. After you have completed your
portfolio, make sure the style you need is selected and click the orange Add Bibliography to
Doc button.
In the following example, the Chicago style has been selected.
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A bibliography for all your citations will then be created similar to the following:

Return to TOC
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Creating Page Numbers
Adding page numbers will help you to refer specific pages within your document and make it
easier for others to locate information within the document. Page number can be added at any
time.

Microsoft Word 2013
Use Insert > Header & Footer > Page Number.

In the drop down list, choose where you want your page numbers (Top of Page or Bottom of
Page) and then choose the style you would like to use to create your page numbers.
In the following example, the student has chosen to place the page numbers in the top right
corner of each page.

Page numbers will be automatically be entered on every page without any further work.
This will add a page number to your title page, table of contents page, and bibliography page. If
you don’t want page numbers on these pages, you can format the page numbering to do this.
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To remove the page number from the title page, click on the page number on any page to
access the Header & Footer toolbar tab. Place a checkmark in the checkbox for Different First
Page. The page number will now be removed from the first page.
Return to TOC

Google Docs
Note: If you are using Google Docs to create your portfolio, you might want to create a
separate document for your title page. When you add page numbers to a Google Doc, all pages
are numbered and cannot be removed from the first page.
Click Insert > Page Numbers to use page numbers in your Google Doc. In the menu, you can
choose Top of Document or Bottom of Document to place your page numbers. Page numbers
will be on the right side of the document for both locations.

Return to TOC
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Creating Your Portfolio from Several Documents
In the Introduction, it was mentioned that it is easiest to create your portfolio in one document.
If this isn’t your case, you can still put all the documents together and then easily create your
Table of Contents, page numbering, and Bibliography.

Microsoft Word 2013
Access one of your documents (the one that you want to add all the other documents to) and
place your cursor at the end of that document. If you want the material from the other
document to start on a new page, then insert a page break.
Use Insert > Text and click on the arrow beside Object.

In the dropdown menu, select Text from file.

In the Insert File dialog box, find the file with the document you wish to insert and click Insert.
The document will be merged into the current document.
Don’t forget to save this new document with a different file name.
Return to TOC

Google Docs
At this point in time, there isn’t a procedure to import text from another document into your
current document.
If you have created separate documents and need to import them into one document, you will
need to manually copy and paste that information from one document into another.
When copying and pasting within Google Docs, the right click > Copy and right click > Paste
method will not work unless you have downloaded the add-on app for Google Doc. If you right
clicking and then copying or pasting, Google Drive will let you know that this feature is not
available and that you need to add it to use it. You cannot do this on the school’s computers as
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Deep Freeze will erase this feature as soon as the computer is turned off. However, this
procedure will work at home as long as you have downloading rights.
Return to TOC
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Creating a Table of Contents
Creating a Table of Contents is really easy if you have set up your document correctly using
headings. If you haven’t used headings in your document, refer to the Creating Headings
section and add headings to the titles of your sections now before you attempt to create your
Table of Contents.

Microsoft Word 2013
Place your cursor in the location of where you want your Table of Contents to be and use
References > Table of Contents > Table of Contents and choose the type of Table of Contents
you want.

Return to TOC
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Google Docs
Google Docs has a built-in Table of Contents creator but it is meant for an online document.
Google Docs Table of Content creator places your headings as hyperlinks in the document but
doesn’t place the page numbers for those headings. Since you will be printing out your
document to hand in to your teacher, you will need to create your Table of Contents manually.
To go the page where you want your Table of Contents and place your cursor at the top of the
page.
It will be helpful to set a right tab as close to the right margin as possible so that you can place
your page numbers in this spot. Click your mouse at 6 1/4 “and choose Add right tab-stop.

Your right tab-stop will look like this:

Type Table of Contents and format the text as you wish. Press the Enter key twice so that you
have a blank line between your Table of Contents title and your next line.
On a new line, type the title of your first section to be included in your Table of Contents and
press the Tab key. You will be taken to the right tab-stop that you created. Type the page
number for that title. Press the Enter key twice to put a blank line between your first section
and the next line.
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Continue with this process until you have completed your Table of Contents. In the example
above you will notice that sections on page number above page 9, the right tab-spot puts the
ones digit lined up with the ones digits above. The tens digit is pushed to the left. This will make
all your page numbers lined up on the right side of the page.
Return to TOC

